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Siemens TCP/IP Server Ethernet-Treiber

INHALT

Übersicht
Was ist Siemens TCP/IP Server Ethernet-Treiber?

Setup
Wie konfiguriere ich ein Gerät für die Verwendung mit diesem Treiber?

Datentypbeschreibung
Welche Datentypen unterstützt dieser Treiber?

Adressbeschreibungen
Wie adressiere ich eine Datenposition auf einem TCP/IP-Ethernet-Gerät von Siemens?

Ereignisprotokollmeldungen
Welche Meldungen erzeugt der Treiber?

Version 1.045
© 2025 PTC Inc. Alle Rechte vorbehalten.

Übersicht
Siemens TCP/IP Server Ethernet-Treiber bietet eine zuverlässige Möglichkeit, Siemens-TCP/IP-Server-
Geräte mit Client-Anwendungen, u.a. HMI, SCADA, Historian, MES, ERP und zahlreichen benutzerdefinierten
Anwendungen, zu verbinden. Dieser Treiber fungiert als simulierte Siemens-SPS. Er ist für die Simulation
von Siemens S7-300 gedacht.
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Setup

Unterstützte Protokolle
S7-Nachrichtenaustausch (Messaging) für Industrial Ethernet (ISO 8073, Klasse 0) über TCP/IP. Dies ist in
RFC1006 festgelegt.

Unterstützte Befehle
FB14-GET (S7-300)
FB15-PUT (S7-300)
SFB14-GET (S7-400, S7-1500)
SFB15-PUT (S7-400, S7-1500)

Kanal- und Gerätegrenzwerte
Die von diesem Treiber unterstützte maximale Anzahl von Kanälen liegt bei 1. Die maximale Anzahl von vir-
tuellen Geräten, die von diesem Treiber unterstützt werden, liegt bei 256 pro Kanal.

Bibliotheken
Dieser Treiber erfordert eine Standard-Ethernet-Karte. Weder spezielle Bibliotheken noch spezielle Hard-
ware sind erforderlich.

Hinweis: Zur Kommunikationmit diesem Treiber benötigen die Geräte spezielle Kontaktpläne.

Kanaleigenschaften
Geräteeigenschaften
Siemens-Client-Gerät-Konfiguration
Anhang: Verbindungen mit dem SIMATIC Manager konfigurieren
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Kanaleigenschaften – Allgemein
Dieser Server unterstützt die Verwendung vonmehreren gleichzeitigen Kommunikationstreibern. Jedes Pro-
tokoll oder jeder Treiber, das/der in einem Serverprojekt verwendet wird, wird als Kanal bezeichnet. Ein Ser-
verprojekt besteht unter Umständen aus vielen Kanälenmit demselben Kommunikationstreiber oder mit
eindeutigen Kommunikationstreibern. Ein Kanal fungiert als grundlegender Baustein eines OPC-Links. Diese
Gruppe wird verwendet, um allgemeine Kanaleigenschaften (wie z.B. die ID-Attribute und den Betriebs-
modus) anzugeben.

Identifikation

Name: Geben Sie die benutzerdefinierte ID dieses Kanals an. Bei jedem Serverprojekt muss jeder Kanal-
name eindeutig sein. Zwar können Namen bis zu 256 Zeichen lang sein, doch haben einige Client-Anwen-
dungen beim Durchsuchen des Tag-Raums des OPC-Servers ein eingeschränktes Anzeigefenster. Der
Kanalname ist ein Teil der OPC-Browserinformationen. Die Eigenschaft ist erforderlich, um einen Kanal zu
erstellen.
Informationen über reservierte Zeichen finden Sie in der Serverhilfe unter „So benennen Sie Kanäle, Geräte,

Tags und Tag-Gruppen richtig“.

Beschreibung: Geben Sie benutzerdefinierte Informationen über diesen Kanal an.
 Viele dieser Eigenschaften, einschließlich der Beschreibung, verfügen über ein zugeordnetes System-Tag.

Treiber: Geben Sie das Protokoll/den Treiber für diesen Kanal an. Geben Sie den Gerätetreiber an, der wäh-
rend der Kanalerstellung ausgewählt wurde. Es ist eine deaktivierte Einstellung in den Kanaleigenschaften.
Die Eigenschaft ist erforderlich, um einen Kanal zu erstellen.
Hinweis: Beim Online-Vollzeitbetrieb des Servers können diese Eigenschaften jederzeit geändert werden.

Dies schließt das Ändern des Kanalnamens ein, um zu verhindern, dass Clients Daten am Server regis-
trieren. Wenn ein Client bereits ein Element vom Server abgerufen hat, bevor der Kanalname geändert
wurde, sind die Elemente davon nicht beeinflusst. Wenn die Client-Anwendung das Element nach der Ände-
rung des Kanalnamens freigibt und versucht, es mit dem alten Kanalnamen erneut abzurufen, wird das Ele-
ment nicht akzeptiert. Es sollten keine Änderungen an den Eigenschaften erfolgen, sobald eine große Client-
Anwendung entwickelt wurde. Verwenden Sie die richtige Benutzerrollen- und Berechtigungsverwaltung, um
zu verhindern, dass Operatoren Eigenschaften ändern oder auf Serverfunktionen zugreifen.

Diagnose

Diagnoseerfassung: Wenn diese Option aktiviert ist, stehen die Diagnoseinformationen des Kanals für OPC-
Anwendungen zur Verfügung. Da für die Diagnosefunktionen des Servers eine minimale Mehr-

www.ptc.com

5



Siemens TCP/IP Server Ethernet-Treiber

aufwandsverarbeitung erforderlich ist, wird empfohlen, dass sie bei Bedarf verwendet werden und ansons-
ten deaktiviert sind. Die Standardeinstellung ist deaktiviert.
Hinweise: Diese Eigenschaft ist nicht verfügbar, wenn der Treiber Diagnosen nicht unterstützt.
Weitere Informationen dazu finden Sie in der Serverhilfe unter "Kommunikationsdiagnosen".

Diagnose

Diagnoseerfassung: Bei Aktivierung dieser Option liefern Client-Anwendungenmithilfe von Statistik-Tags
Feedback über die Kanaloperation. Da für die Diagnosefunktionen des Servers eine minimale Mehr-
aufwandsverarbeitung erforderlich ist, wird empfohlen, dass sie bei Bedarf verwendet werden und ansons-
ten deaktiviert sind. Die Standardeinstellung ist deaktiviert.
Hinweise: Diese Eigenschaft ist nicht verfügbar, wenn der Treiber Diagnosen nicht unterstützt.
Weitere Informationen dazu finden Sie in der Serverhilfe unter "Statistik-Tags".

Tag-Zähler

Statische Tags: Gibt die Gesamtanzahl der definierten statischen Tags auf dieser Ebene (Gerät oder Kanal)
an. Diese Informationen können bei der Problembehandlung und beim Lastenausgleich hilfreich sein.

Kanaleigenschaften – Ethernet-Kommunikation
Ethernet-Kommunikation kann für die Kommunikationmit Geräten verwendet werden.

Ethernet-Einstellungen

Netzwerkadapter: Geben Sie den zu bindenden Netzwerkadapter an. Wird dieses Feld leer gelassen oder
es wird "Standard" ausgewählt, so wählt das Betriebssystem den Standardadapter aus.

Kanaleigenschaften – Schreiboptimierungen
Der Server muss sicherstellen, dass die von der Client-Anwendung geschriebenen Daten rechtzeitig auf das
Gerät gelangen. In Anbetracht dieses Ziels stellt der Server Optimierungseigenschaften bereit, um die jewei-
ligen Anforderungen zu erfüllen bzw. die Reaktionsfähigkeit der Anwendungen zu verbessern.

Schreiboptimierungen

Optimierungsmethode: Mit dieser Option wird gesteuert, wie Schreibdaten an den zugrunde liegenden
Kommunikationstreiber weitergeleitet werden. Die Optionen sind:

l Alle Werte für alle Tags schreiben: Mit dieser Option wird der Server gezwungen, für jedenWert
einen Schreibvorgang auf dem Controller zu versuchen. In diesemModus sammelt der Server
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weiterhin Schreibanforderungen und fügt sie der internen Schreibwarteschlange des Servers hinzu.
Der Server verarbeitet die Schreibwarteschlange und versucht, sie zu leeren, indem er so schnell wie
möglich Daten auf das Gerät schreibt. In diesemModus wird sichergestellt, dass alles, was von den
Client-Anwendungen geschrieben wird, an das Zielgerät gesendet wird. Dieser Modus sollte aus-
gewählt werden, wenn die Reihenfolge des Schreibvorgangs oder der Inhalt des Schreibelements ein-
deutig auf dem Zielgerät zu finden sein muss.

l Nur den letzten Wert für nicht boolesche Tags schreiben: Viele aufeinander folgende Schreib-
vorgänge für denselbenWert können sich aufgrund der Zeit, die tatsächlich zum Senden der Daten
auf das Gerät erforderlich ist, in der Schreibwarteschlange ansammeln. Wenn der Server einen
Schreibwert aktualisiert, der bereits in die Schreibwarteschlange eingefügt wurde, sind weitaus weni-
ger Schreibvorgänge erforderlich, um denselben Endausgabewert zu erhalten. Auf diese Weise sam-
meln sich keine zusätzlichen Schreibvorgänge in der Warteschlange des Servers an. Wenn der
Benutzer den Schiebeschalter nicht mehr verschiebt, erreicht der Wert im Gerät praktisch in der-
selben Zeit den richtigenWert. DemModus entsprechend wird jeder Wert, der kein boolescher Wert
ist, in der internenWarteschlange des Servers aktualisiert und bei der nächstmöglichen Gelegenheit
an das Gerät gesendet. Dies kann die Anwendungsleistung erheblich verbessern.
Hinweis: Mit dieser Option wird nicht versucht, Schreibvorgänge in Boolesche Werte zu opti-

mieren. Dadurch können Benutzer den HMI-Datenvorgang optimieren, ohne Probleme mit Boo-
leschen Operationen (z.B. eine vorübergehende Schaltfläche) zu verursachen.

l Nur den letzten Wert für alle Tags schreiben: Mit dieser Option wird die hinter der zweiten Opti-
mierungsmethode stehende Theorie auf alle Tags angewendet. Sie ist besonders nützlich, wenn die
Anwendung nur den letztenWert an das Gerät sendenmuss. In diesemModus werden alle Schreib-
vorgänge optimiert, indem die derzeit in der Schreibwarteschlange befindlichen Tags vor dem Sen-
den aktualisiert werden. Dies ist der Standardmodus.

Servicezyklus: Wird verwendet, um das Verhältnis von Schreib- und Lesevorgängen zu steuern. Das Ver-
hältnis basiert immer auf einem Lesevorgang für jeden zehnten Schreibvorgang. Für den Servicezyklus wird
standardmäßig 10 festgelegt. Dies bedeutet, dass 10 Schreibvorgänge für jeden Lesevorgang erfolgen.
Zwar führt die Anwendung eine große Anzahl fortlaufender Schreibvorgänge durch, dochmuss sicher-
gestellt werden, dass es für Lesedaten weiterhin Verarbeitungszeit gibt. Die Einstellung 1 hat zur Folge, dass
ein Lesevorgang für jeden Schreibvorgang erfolgt. Wenn es keine durchzuführenden Schreibvorgänge gibt,
werden Lesevorgänge fortlaufend verarbeitet. Dies ermöglicht eine Optimierung für Anwendungenmit fort-
laufenden Schreibvorgängen gegenüber einem ausbalancierteren Datenzufluss und -abfluss.
Hinweis: Es wird empfohlen, dass für die Anwendung die Kompatibilität mit den Verbesserungen zur

Schreiboptimierung charakteristisch ist, bevor sie in einer Produktionsumgebung verwendet wird.

Kanaleigenschaften – Erweitert
Diese Gruppe wird verwendet, um erweiterte Kanaleigenschaften anzugeben. Nicht alle Treiber unter-
stützen alle Eigenschaften; so wird die Gruppe "Erweitert" für jene Geräte nicht angezeigt.

Nicht normalisierte Float-Handhabung: Ein nicht normalisierter Wert wird als "Unendlich", "Nicht-
zahlenwert (NaN)" oder als "Denormalisierte Zahl" definiert. Die Standardeinstellung ist Durch Null
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ersetzen. Für Treiber, die eine native Float-Handhabung aufweisen, wird standardmäßig unter Umständen
"Nicht geändert" verwendet. Durch Behandlung nicht normalisierter Gleitkommazahlen können Benutzer
festlegen, wie ein Treiber mit nicht normalisierten IEEE-754-Gleitkommadaten umgeht. Es folgen Beschrei-
bungen der Optionen:

l Durch Null ersetzen: Diese Option ermöglicht es einem Treiber, nicht normalisierte IEEE-754-Gleit-
kommawerte durch Null zu ersetzen, bevor sie an Clients übertragen werden.

l Nicht geändert: Diese Option ermöglicht es einem Treiber, denormalisierte, normalisierte IEEE-754-
Nichtzahlenwerte und unendliche IEEE-754-Werte ohne jegliche Konvertierung oder Änderungen an
Clients zu übertragen.

Hinweis: Diese Eigenschaft ist deaktiviert, wenn der Treiber keine Gleitkommawerte unterstützt, oder
wenn er nur die angezeigte Option unterstützt. Gemäß der Float-Normalisierungseinstellung des Kanals
unterliegen nur Echtzeit-Treiber-Tags (wie z.B. Werte und Arrays) der Float-Normalisierung. Beispielsweise
werden EFM-Daten nicht durch diese Einstellung beeinflusst.

Weitere Informationen über die Gleitkommawerte finden Sie unter "Mit nicht normalisierten Gleitkommawerten
arbeiten" in der Serverhilfe.

Verzögerung zwischen Geräten: Geben Sie die Zeitdauer an, in der der Kommunikationskanal das Senden
einer Anforderung an das nächste Gerät verzögert, nachdem Daten vom aktuellen Gerät in demselben
Kanal empfangen wurden. Null (0) deaktiviert die Verzögerung.

Hinweis: Diese Eigenschaft ist nicht für alle Treiber, Modelle und abhängige Einstellungen verfügbar.

Kanaleigenschaften – Kommunikationseigenschaften

Port-Nummer: Gibt die Port-Nummer an, unter der der Treiber empfangsbereit ist. Geräte müssen so kon-
figuriert sein, dass sie eine Verbindung über diesen Port herstellen: An andere Ports gesendete Nachrichten
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werden vom Treiber ignoriert. Der gültige Bereich liegt zwischen 0 und 65535. Die Standardeinstellung ist
TCP/IP: 102 (TSAP).

Hinweis: Nicht dem Standard entsprechende Werte sindmöglicherweise aufgrund von Routing- und Fire-
wall-Problemen erforderlich.
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Geräteeigenschaften – Allgemein
Ein Gerät stellt ein einzelnes Ziel in einem Kommunikationskanal dar. Wenn der Treiber mehrere Controller
unterstützt, müssen Benutzer eine Geräte-ID für jeden Controller eingeben.

Identifikation

Name:  Geben Sie den Namen des Geräts an. Es ist ein logischer, benutzerdefinierter Name, der bis zu 256
Zeichen lang sein und auf mehreren Kanälen verwendet werden kann.

Hinweis: Zwar sind beschreibende Namen allgemein eine gute Idee, doch haben einige OPC-Client-
Anwendungen beim Durchsuchen des Tag-Raums des OPC-Servers möglicherweise ein eingeschränktes
Anzeigefenster. Der Geräte- und Kanalname werden ebenfalls Teil der Informationen zum Durchsuchen der
Hierarchiebaumstruktur. Innerhalb eines OPC-Clients würde die Kombination aus Kanalname und Gerä-
tename als "ChannelName.DeviceName" angezeigt werden.
Weitere Informationen dazu finden Sie in der Serverhilfe unter "So benennen Sie Kanäle, Geräte, Tags und Tag-

Gruppen richtig".

Beschreibung: Geben Sie die benutzerdefinierten Informationen über dieses Gerät an.
 Viele dieser Eigenschaften, einschließlich der Beschreibung, verfügen über ein zugeordnetes System-Tag.

Kanalzuweisung: Geben Sie den benutzerdefinierten Namen des Kanals an, zu dem dieses Gerät derzeit
gehört.

Treiber: Ausgewählter Protokolltreiber für dieses Gerät.

Modell:  Geben Sie den Gerätetyp an, der dieser ID zugeordnet ist. Der Inhalt des Dropdown-Menüs hängt
vom Typ des verwendeten Kommunikationstreibers ab. Modelle, die von einem Treiber nicht unterstützt wer-
den, sind deaktiviert. Wenn der Kommunikationstreiber mehrere Gerätemodelle unterstützt, kann die Model-
lauswahl nur geändert werden, wenn keine Client-Anwendungenmit dem Gerät verbunden sind.

Hinweis: Wenn der Kommunikationstreiber mehrere Modelle unterstützt, sollten Benutzer versuchen, die
Modellauswahl mit dem physischen Gerät abzugleichen. Wenn das Gerät im Dropdown-Menü nicht dar-
gestellt wird, wählen Sie ein Modell aus, das dem Zielgerät am ehesten entspricht. Einige Treiber unter-
stützen die Modellauswahl "Offen", wodurch Benutzer kommunizieren können, ohne bestimmte Details des
Zielgeräts zu kennen.Weitere Informationen dazu finden Sie in der Dokumentation für den Treiber.

ID:  Geben Sie die treiberspezifische Station oder den treiberspezifischen Knoten für das Gerät an. Der Typ
der eingegebenen ID hängt vom verwendeten Kommunikationstreiber ab. Für viele Kommunikationstreiber
ist die ID ein numerischer Wert. Treiber, die eine numerische ID unterstützen, stellen Benutzern die Option
zum Eingeben eines numerischenWerts bereit, dessen Format den Anforderungen der Anwendung oder
der Charakteristik des ausgewählten Kommunikationstreibers entsprechend angepasst werden kann. Das
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Format wird standardmäßig durch den Treiber festgelegt. Zu den Optionen gehören "Dezimal", "Oktal" und
"Hexadezimal".

Hinweis: Wenn der Treiber Ethernet-basiert ist oder eine unkonventionelle Station oder einen unkon-
ventionellen Knotennamen unterstützt, kann die TCP/IP-Adresse des Geräts ggf. als Geräte-ID verwendet
werden. TCP/IP-Adressen bestehen aus vier Werten, die durch Punkte getrennt sind, wobei jeder Wert im
Bereich von 0 bis 255 liegt. Einige Geräte-IDs sind zeichenfolgenbasiert. Abhängig vom Treiber gibt es mög-
licherweise zusätzliche zu konfigurierende Eigenschaften innerhalb des ID-Felds.

Betriebsmodus

Datensammlung: Diese Eigenschaft steuert den aktiven Status des Geräts. Zwar sind Gerä-
tekommunikationen standardmäßig aktiviert, doch kann diese Eigenschaft verwendet werden, um ein physi-
sches Gerät zu deaktivieren. Kommunikationen werden nicht versucht, wenn ein Gerät deaktiviert ist. Vom
Standpunkt eines Clients werden die Daten als ungültig markiert und Schreibvorgänge werden nicht akzep-
tiert. Diese Eigenschaft kann jederzeit durch diese Eigenschaft oder die System-Tags des Geräts geändert
werden.

Simuliert:  Versetzen Sie das Gerät in den Simulationsmodus, oder beenden Sie denModus. In diesem
Modus versucht der Treiber nicht, mit dem physischen Gerät zu kommunizieren, aber der Server gibt wei-
terhin gültige OPC-Daten zurück. Durch Auswählen von "Simuliert" wird die physische Kommunikationmit
dem Gerät angehalten, OPC-Daten können jedoch als gültige Daten dem OPC-Client zurückgegeben wer-
den. Im Simulationsmodus behandelt der Server alle Gerätedaten als reflektierend: was auch immer in das
simulierte Gerät geschrieben wird, wird zurückgelesen, und jedes OPC-Element wird einzeln behandelt. Die
Daten werden nicht gespeichert, wenn der Server das Element entfernt (z.B., wenn der Server neu initia-
lisiert wird). Die Standardeinstellung ist "Nein".

Hinweise:
1. Aktualisierungen werden erst nach dem Trennen von Clients und nach demWiederherstellen von deren

Verbindung angewendet.

2. Das System-Tag (_Simulated) ist schreibgeschützt und kann für den Laufzeitschutz nicht geschrieben wer-
den. Das System-Tag ermöglicht es, dass diese Eigenschaft vom Client überwacht wird.

3. Im Simulationsmodus basiert die Speicherzuordnung des Elements auf Client-Aktualisierungsraten (Grup-
penaktualisierungsrate für OPC-Clients oder Scan-Intervall für native und DDE-Schnittstellen). Das bedeu-
tet, dass zwei Clients, die dasselbe Element mit unterschiedlichen Aktualisierungsraten referenzieren,
verschiedene Daten zurückgeben.

4. Wird ein Gerät simuliert, so werden Aktualisierungenmöglicherweise nicht schneller als innerhalb einer
Sekunde auf dem Client angezeigt.

 Der Simulationsmodus ist nur für Test- und Simulationszwecke. Es sollte niemals in einer Pro-
duktionsumgebung nie verwendet werden.
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Tag-Zähler

Statische Tags: Gibt die Gesamtanzahl der definierten statischen Tags auf dieser Ebene (Gerät oder Kanal)
an. Diese Informationen können bei der Problembehandlung und beim Lastenausgleich hilfreich sein.

Geräteeigenschaften – Scan-Modus
Der Scan-Modus gibt das vom abonnierten Client angeforderte Scan-Intervall für Tags an, die Gerä-
tekommunikation erfordern. Synchrone und asynchrone Lese- und Schreibvorgänge des Geräts werden so
bald wie möglich verarbeitet; unbeeinflusst von den Eigenschaften für den Scan-Modus.

Scan-Modus: Geben Sie an, wie Tags im Gerät für an abonnierende Clients gesendete Aktualisierungen
gescannt werden. Es folgen Beschreibungen der Optionen:

l Vom Client angegebenes Scan-Intervall berücksichtigen: Dieser Modus verwendet das vom Cli-
ent angeforderte Scan-Intervall.

l Datenanfrage nicht schneller als Scan-Intervall: Dieser Modus gibt denWert an, der als maxi-
males Scan-Intervall festgelegt wurde. Der gültige Bereich liegt zwischen 10 und 99999990 Mil-
lisekunden. Die Standardeinstellung ist 1000 Millisekunden.
Hinweis: Wenn der Server über einen aktiven Client und Elemente für das Gerät verfügt und der

Wert für das Scan-Intervall erhöht wird, werden die Änderungen sofort wirksam. Wenn der Wert für
das Scan-Intervall verringert wird, werden die Änderungen erst wirksam, wenn alle Client-Anwen-
dungen getrennt wurden.

l Alle Datenanfragen im Scan-Intervall: Dieser Modus erzwingt, dass Tags im angegebenen Inter-
vall nach abonnierten Clients gescannt werden. Der gültige Bereich liegt zwischen 10 und 99999990
Millisekunden. Die Standardeinstellung ist 1000 Millisekunden.

l Nicht scannen, nur Abruf anfordern: In diesemModus werden Tags, die zum Gerät gehören, nicht
periodisch abgerufen, und es wird auch kein Lesevorgang durchgeführt, um den Anfangswert eines
Elements abzurufen, sobald es aktiv wird. Es liegt in der Verantwortung des OPC-Clients, Aktua-
lisierungen abzurufen, entweder durch Schreiben in das _DemandPoll-Tag oder durch Ausgeben
expliziter Lesevorgänge des Geräts für einzelne Elemente.Weitere Informationen finden Sie unter
"Geräte-Bedarfsabruf" in der Serverhilfe.

l Durch Tag angegebenes Scan-Intervall berücksichtigen:  Dieser Modus erzwingt das Scannen
statischer Tags im Intervall, das in ihrer statischen Konfiguration Tag-Eigenschaften angegeben
wurde. Dynamische Tags werden in dem vom Client angegebenen Scan-Intervall gescannt.

Anfangsaktualisierungen aus Cache: Wenn diese Option aktiviert ist, kann der Server die ersten Aktua-
lisierungen für neu aktivierte Tag-Referenzen aus gespeicherten (Cache-)Daten zur Verfügung stellen.
Cache-Aktualisierungen können nur bereitgestellt werden, wenn die neue Elementreferenz dieselben Eigen-
schaften für Adresse, Scan-Intervall, Datentyp, Client-Zugriff und Skalierung gemeinsam nutzt. Ein Lese-
vorgang des Geräts wird nur für die Anfangsaktualisierung für die erste Client-Referenz verwendet. Der
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Standardeinstellung ist "Deaktiviert"; immer wenn ein Client eine Tag-Referenz aktiviert, versucht der Ser-
ver, den Anfangswert vom Gerät zu lesen.

Geräteeigenschaften – CPU-Einstellungen

Rack-Nummer: Diese Eigenschaft gibt die Nummer des Racks an, in dem sich die entsprechende simulierte
CPU befindet. Der gültige Bereich liegt zwischen 0 und 7. Geräte müssen eindeutige Rack- und Steck-
platzwerte aufweisen. Die Standardeinstellung ist 0.

CPU-Steckplatz: Diese Eigenschaft gibt die Nummer des Steckplatzes an, in dem sich die entsprechende
simulierte CPU befindet. Der gültige Bereich liegt zwischen 0 und 31. Geräte müssen eindeutige Rack- und
Steckplatzwerte aufweisen. Die Standardeinstellung ist 0.

Maximale PDU-Größe: Diese Eigenschaft gibt die maximale Größe der Protokolldateneinheit, die der Ser-
ver unterstütz, an. Sie kann auf 240, 480 oder 960 Bytes konfiguriert werden.

Hinweis: Verwenden Sie das interne Tag _CurrentPDUSize, um die mit dem Gerät verhandelte PDU-
Größe zu berücksichtigen (siehe Interne Tags).
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Siemens Client-Gerät-Konfiguration
Siemens-SPS müssen so programmiert werden, dass Lese- und Schreibbefehle an den Treiber ausgegeben
und zurückgegebene Daten bearbeitet werden.Weitere Informationen dazu finden Sie in der Dokumentation
zur Siemens-SPS-Programmierung. Informationen zum Vorbereiten des Siemens-Geräts und des unauf-
geforderten Treibers für die Kommunikation finden Sie unter Verbindungen mit dem SIMATIC Manager kon-
figurieren.

Meldungenmüssen an die IP-Adresse des ausgewählten Ethernet-Adapters für den Host-Computer, auf
dem der unaufgeforderte Treiber ausgeführt wird, gesendet werden. Aktualisieren Sie dazu die Kana-
leigenschaften.
Weitere Informationen zu der für das simulierte Gerät konfigurierten Port-Nummer finden Sie unter Kom-

munikationseigenschaften.

Interne Tags
Zwar sind die folgenden internen Tags in der Serverkonfiguration nicht sichtbar, doch können Sie durch den
OPC-Client durchsucht werden. Sie können unter <Kanalname> gefunden werden.<Gerätename>._
InternalTags-Gruppe. Wenn der OPC-Client kein Suchen unterstützt oder ein Nicht-OPC-Client verwendet
wird, können die Tags anhand der unten angegebenen Adressen dynamisch und statisch erstellt werden.

Geräteadresse Beschreibung Bereich Datentyp Zugriff

_CurrentPDUSize Nach der Verbindungsherstellung zeigt dieses Tag
die Größe der Protokolldateneinheit, die mit dem
Gerät verhandelt wurde, an. Vor der Ver-
bindungsherstellung zeigt das Tag denmaximalen
konfigurierten PDU-Wert an.

240,
480, 960

Word Lesen
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Datentypbeschreibung

Datentyp Beschreibung

Boolean Einzelnes Bit

Byte 8-Bit-Wert ohne Vorzeichen

Char 8-Bit-Wert mit Vorzeichen

Word 16-Bit-Wert ohne Vorzeichen

Bit 0 ist das Low-Bit

Bit 15 ist das High-Bit

Short 16-Bit-Wert mit Vorzeichen

Bit 0 ist das Low-Bit

Bit 14 ist das High-Bit

Bit 15 ist das Vorzeichen-Bit

DWord 32-Bit-Wert ohne Vorzeichen

Bit 0 ist das Low-Bit

Bit 31 ist das High-Bit

Long 32-Bit-Wert mit Vorzeichen

Bit 0 ist das Low-Bit

Bit 30 ist das High-Bit

Bit 31 ist das Vorzeichen-Bit

BCD Gepacktes 2-Byte-BCD

Der Wertebereich liegt zwischen 0 und 9999. Für Werte außerhalb dieses
Bereichs ist das Verhalten nicht definiert.

LBCD Gepacktes 4-Byte-BCD

Der Wertebereich liegt zwischen 0 und 99999999. Für Werte außerhalb dieses
Bereichs ist das Verhalten nicht definiert.

Float 32-Bit-Gleitkommawert.

Der Treiber interpretiert zwei aufeinanderfolgende Register als Gleitkommawert,
indem das erste Register als Low-Wort und das zweite Register als High-Wort
bewertet wird.

String Mit Null beendete ASCII-Zeichenfolge
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Adressbeschreibungen
Die folgenden Informationen gelten für die Modelle S7-300 und S7-400. Die Standard-Datentypen für dyna-
misch definierte Tags werden fett dargestellt.

Adresstyp Bereich Typ Zugriff

Einzelne Eingaben I0.b-I4095.b*

.b ist die Bit-Nummer 0–7

IB0-IB4095

IW0-IW4094

IW:KT0-IW:KT4094

IW:KC0-IW:KC4094

ID0-ID4092

Boolean

Byte, Char, String**

Word, Short, BCD

DWord, Long

Word, Short

DWord, Long, LBCD, Float

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Einzelne Eingaben

Hinweis: I und E greifen
auf denselben Speicher-
bereich zu.

E0.b-E4095.b*

.b ist die Bit-Nummer 0–7

EB0-EB4095**

EW0-EW4094

EW:KT0-EW:KT4094

EW:KC0-EW:KC4094

ED0-ED4092

Boolean

Byte, Char, String**

Word, Short, BCD

DWord, Long

Word, Short

DWord, Long, LBCD, Float

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Einzelne Ausgaben Q0.b-Q4095.b*

.b ist die Bit-Nummer 0–7

QB0-QB4095

QW0-QW4094

QW:KT0-QW:KT4094

QW:KC0-QW:KC4094

QD0-QD4092

Boolean

Byte, Char, String**

Word, Short, BCD

DWord, Long

Word, Short

DWord, Long, LBCD, Float

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Einzelne Ausgaben

Hinweis: Q und A greifen
auf denselben Speicher-
bereich zu.

A0.b- A4095.b*

.b ist die Bit-Nummer 0–7

AB0-AB4095

AW0-AW4094

AW:KT0-AW:KT4094

AW:KC0-AW:KC4094

AD0-AD4092

Boolean

Byte, Char, String**

Word, Short, BCD

DWord, Long

Word, Short

DWord, Long, LBCD, Float

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Interner Speicher F0.b-F4095.b*

.b ist die Bit-Nummer 0–7

FB0-FB4095

FW0-FW4094

FW:KT0-FW:KT4094

FW:KC0-FW:KC4094

FD0-FD4092

Boolean

Byte, Char, String**

Word, Short, BCD

DWord, Long

Word, Short

DWord, Long, LBCD, Float

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Interner Speicher

Hinweis: F undM grei-

M0.b-M4095.b*

.b ist die Bit-Nummer 0–7

MB0-MB4095

Boolean

Byte, Char, String**

Word, Short, BCD

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben
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Adresstyp Bereich Typ Zugriff

fen auf denselben Speicher-
bereich zu.

MW0-MW4094

MW:KT0-MW:KT4094

MW:KC0-MW:KC4094

MD0- MD4092

DWord, Long

Word, Short

DWord, Long, LBCD, Float

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Datenblock – Boolean DB1-N:KM0.b-KM4094.b*

1-n ist die Blocknummer

.b ist die Bit-Nummer 0–15

Alternativteile

DB1DBX0.b-
DBNDBX4094.b*

1-n ist die Blocknummer

.b ist die Bit-Nummer 0–15

DB1D0.b-DBND4094.b*

1-n ist die Blocknummer

.b ist die Bit-Nummer 0–15

Boolean

Boolean

Boolean

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Datenblock – linkes Byte DB1-N:KL0-KL4095

1-n ist die Blocknummer

Alternativteile

DB1DBB0-DBNDBB4095

1-n ist die Blocknummer

DB1DL0-DBNDL4095

1-n ist die Blocknummer

Byte, Char, String**

Byte, Char, String**

Byte, Char, String**

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Datenblock – rechtes Byte DB1-N:KR0-KR4094

1-n ist die Blocknummer

Alternativteile

DB1DR0-DBNDR4094

1-n ist die Blocknummer

Byte, Char, String**

Byte, Char, String**

Lesen/Schreiben

Lesen/Schreiben

Datenblock – Word ohne
Vorzeichen

DB1-N:KH0-KH4094

1-n ist die Blocknummer

Word, Short, BCD Lesen/Schreiben

Datenblock – Wordmit Vor-
zeichen

DB1-N:KF0-KF4094

1-n ist die Blocknummer

Alternativteile

DB1DBW0-DBNDBW4094

1-n ist die Blocknummer

DB1DW0-DBNDW4094

1-n ist die Blocknummer

Word, Short, BCD

Word, Short, BCD

Word, Short, BCD

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben

Datenblock – Long mit Vor-
zeichen

DB1-N:KD0-KD4092

1-n ist die Blocknummer

Alternativteile

DB1DBD0-DB1DBD4092

1-n ist die Blocknummer

DB1DD0-DB1DD4092

DWord, Long, LBCD, Float

DWord, Long, LBCD, Float

DWord, Long, LBCD, Float

Lesen/Schreiben

Lesen/Schreiben

Lesen/Schreiben
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Adresstyp Bereich Typ Zugriff

1-n ist die Blocknummer

Datenblockgleitkommazahl DB1-N:KG0-KG4092

1-n ist die Blocknummer
Float Lesen/Schreiben

Datenblock – BCD DB1-N:BCD0-BCD4094

1-n ist die Blocknummer

Word, Short Lesen/Schreiben

Datenblock – S5-Zeitgeber
als DB

DB1-N:KT0-KT4094

1-n ist die Blocknummer

DWord, Long Lesen/Schreiben

Datenblock – S5-Zähler als
DB

DB1-N:KC0-KC4094

1-n ist die Blocknummer

Word, Short Lesen/Schreiben

Datenblockzeichenfolge DB1:S0.n-DB1:S4095.n*

.n ist die Zei-
chenfolgenlänge.

0<n<= 932

String Lesen/Schreiben

*Diese Speichertypen/-untertypen unterstützen keine Arrays.
**Byte-Speichertypen (MB) unterstützen Zeichenfolgen. Die Syntax für Zeichenfolgen lautet <Adres-
se>.<Länge> wobei 0<Länge<=932.

Hinweise:

1. Alle Offsets für die Speichertypen I, Q und F stellen eine Byte-Startposition innerhalb des ange-
gebenen Speichertyps dar.

2. Gehen Sie vorsichtig vor beim Bearbeiten der Typen "Word", "Short", "DWord" und "Long". Für I, Q
und F beginnt jede Adresse innerhalb des Geräts mit einem Byte-Offset. Deshalb überlappen sich die
Wörter FW0 und FW1 bei Byte 1. Durch das Schreiben in FW0 wird der in FW1 enthaltene Wert geän-
dert. Ebenso können die Typen "DWord" und "Long" sich überlappen. Es wird empfohlen, diese
Arbeitsspeichertypen so zu verwenden, dass kein Überlappen auftritt. Bei der Verwendung von
DWord kann beispielsweise durch FD0, FD4 und FD8 verhindert werden, dass Bytes überlappen.

3. Für Zeichenfolgen darf die Gesamtzahl der angeforderten Bytes den Datenteil der verhandelten
PDU-Größe nicht überschreiten. Überschreiten rohe Zeichenfolgen die verhandelte PDU-Größe, kön-
nen sie u.U. nicht gelesen oder geschrieben werden.

Arrays
Alle Speichertypen/-untertypen unterstützen Arrays (ausgenommen die zuvor beschriebenen). Die gültige
Syntax zum Deklarieren eines Arrays wird im Folgenden beschrieben. Wenn keine Zeilen angegeben wer-
den, wird die Zeilenanzahl 1 angenommen.

<Adresse>[Zeilen][Spalten]
<Adresse>.Zeilen.Spalten
<Adresse>,Zeilen,Spalten
<Adresse>_Zeilen_Spalten

Für die Arrays "Word", "Short", "BCD" und "KT" darf die Basisadresse + (Zeilen * Spalten * 2) denWert 4096
nicht überschreiten. Die Elemente des Arrays sindWörter und befinden sich auf einer Wortgrenze. Zum Bei-
spiel gibt IW0[4] die Werte IW0, IW2, IW4 und IW6 zurück. KT-Untertypen fallen in die 16-Bit-Kategorie, weil
die in der SPS gespeicherten Daten in einemWord enthalten sind.
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Für die Arrays "Float", "DWord", "Long" und "Long BCD" (ausschließlich "KT"-Untertypen) darf die Basi-
sadresse + (Zeilen * Spalten * 4) denWert 4096 nicht überschreiten. Beachten Sie, dass die Elemente des
Arrays aus DWord bestehen und sich auf einer DWord-Grenze befinden. Zum Beispiel gibt ID0[4] die Werte
ID0, ID4, ID8 und ID12 zurück.

Für alle Arrays darf die Gesamtzahl der angeforderten Bytes den Datenteil der verhandelten PDU-Größe
nicht überschreiten. Beispiel: Bei einer PDU-Größe von 960 Byte, darf das größte einzelne Array, das
geschrieben oder gelesen wird, 932 Byte betragen.

Vergleich von KL mit KR und DBB
KL und KR bestimmen, ob das linke oder das rechte Byte des Datenblockworts zurückgegeben wird.

Wert 8 9 A B C

Byte 0 1 2 3 4

Beispiel 1
DB1:KH0=0x89
DB1:KL0=0x8
DB1:KR0=0x9
DB1DBB0=0x8

Beispiel 2
DB1:KH1=0x9A
DB1:KL1=0x9
DB1:KR1=0xA
DB1DBB1=0x9

Beispiele

l Um auf Bit 3 des internen Speichers F20 zuzugreifen, deklarieren Sie eine Adresse wie folgt: F20.3.

l Um auf Datenblock 5 als Wortspeicher bei Byte 30 zuzugreifen, deklarieren Sie eine Adresse wie
folgt: DB5:KH30.

l Um auf Datenblock 2 (Byte 20 und Bit 7) zuzugreifen, deklarieren Sie eine Adresse wie folgt:
DB2:KM20.7.

l Um auf Datenblock 1 als Speicher mit linker Byte-Orientierung bei Byte 10 zuzugreifen, deklarieren
Sie eine Adresse wie folgt: DB1:KL10.

l Um auf den internen Speicher F20 als ein DWord zuzugreifen, deklarieren Sie eine Adresse wie folgt:
FD20.

l Um auf den Eingabespeicher I10 als ein Word zuzugreifen, deklarieren Sie eine Adresse wie folgt:
IW10.
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Ereignisprotokollmeldungen
Die folgenden Informationen betreffen Meldungen, die im Fensterbereich Ereignisprotokoll in der Haupt-
benutzeroberfläche angezeigt werden. Informationen zum Filtern und Sortieren der Detailansicht Ereig-
nisprotokoll finden Sie in der OPC-Serverhilfe. In der Serverhilfe sind viele allgemeine Meldungen enthalten,
die also auch gesucht werden sollten. Im Allgemeinen werden die Art der Meldung (Information, Warnung)
sowie Fehlerbehebungsinformationen bereitgestellt (sofern möglich).

Tipp: Meldungen, die aus einer Datenquelle stammen (z.B. Drittanbieter-Software, einschließlich Daten-
banken), werden über das Ereignisprotokoll dargestellt. Die Schritte der Problembehandlung sollten eine
Recherche zu diesenMeldungen im Internet und in der Händlerdokumentation beinhalten.

Unangeforderte Kommunikation konnte nicht gestartet werden. | Port-
Nummer = <Nummer>.
Fehlertyp:
Fehler

Mögliche Ursache:

1. Der Treiber konnte keinen zu überwachenden Socket für unangeforderte Kommunikation erstellen.
Eine andere Anwendung verwendet möglicherweise den angegebenen Port.

2. Möglicherweise sind die Systemressourcen niedrig.

Mögliche Lösung:

1. Verwenden Sie eine Software zur Netzwerküberwachung, um festzustellen, ob der Port von einer
anderen Anwendung genutzt wird. Falls ja, fahren Sie die Anwendung, mit der ein Konflikt besteht,
herunter, und starten Sie den OPC-Server neu. Wenn die besagte Anwendung jeden verfügbaren Port
auswählen kann, stellen Sie sicher, dass der Server immer zuerst gestartet wird, damit er den benö-
tigten Port beanspruchen kann. Wenn die SPS-Programmiersoftware wie auch dieser Treiber den-
selben Port verwendenmüssen, können ggf. nicht beide gleichzeitig verwendet werden.

2. Stellen Sie sicher, dass genügend Systemressourcen vorhanden sind, oder geben Sie von anderen
Prozessen beanspruchte Ressourcen frei.

 Siehe auch:
Kanal-Setup
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Appendix: Configuring Connections Using the
SIMATIC Manager
Connections are configured using the SIMATIC Manager software. The following topics provide information
on configuring the Siemens TCP/IP Server Ethernet-Treiber to run in unsolicited mode, and demonstrate a
basic setup using the S7-300 PLC as the active partner and the driver as the passive partner.

Note: The Siemens TCP/IP Server Ethernet-Treibercan configure 256 devices, each with an associated
slot/rack. When the active partner (Siemens client) communicates with the passive partner (unsolicited or
Siemens server driver), it directs its requests to a specific device in the unsolicited driver. Multiple remote
partners can talk to the same device.

To jump to a specific section, select a link from the list below.

Step One: Creating a New Project
Step Two: Configuring the Siemens Client and PC Station
Step Three: Connecting the Siemens Client and the Siemens Server Driver
Step Four: Inserting Function Blocks
Step Five: Creating the DB3 Data Block
Step Six: Inserting PUT FB
Step Seven: Downloading to the PLC

Step One: Creating a New Project

1. To start, open the SIMATIC Manager software and then create a new project. In this example, the pro-
ject being used is "Setup".
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2. Create the Siemens client and PC Station. To do so, right-click in the right pane of the window and
then select Insert New Object | SIMATIC 300 Station.

Tip: The Siemens client unit is the active partner or the image of the actual PC. The PC Station is
the PC on which the SIMATIC Manager software is running.
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3. Name the new station "SIEMENS-CLIENT" because it represents the communication's active partner.

4. Right-click in the right pane of the window and select Insert New Object | SIMATIC PC Station.
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 For more information, refer to Step Two: Configuring the Siemens Client and PC Station.

Step Two: Configuring the Siemens Client and PC Station
Industrial Ethernet (IE) is the protocol used for communication.

1. To start, right-click in the right pane of the SIMATIC Manager window. Select Insert New Object |
Industrial Ethernet.
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2. Select the SIEMENS CLIENT icon in the left pane of the window and double-clickHardware.
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3. Open the View tab and select Catalog.

4. Expand the SIMATIC 300menu and the Rack 300menu.
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5. To insert the racks, double-click on Rail.

6. Expand the PS 300menu. Double-click on PS 307 10A or any other suitable option to insert the
power supply into slot 1.
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7. To insert the CPU, expand both the CPU 300menu and the CPU 315-2 DP menu.
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8. Double-click on the CPU that matches the hardware.
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9. To insert the CPU into slot 2, clickOK.

10. To insert the CP, leave slot 3 empty and then click on slot 4 in the racks.

11. Expand both the CP 300menu and the Industrial Ethernetmenu.

12. Double-click on the CP that matches the hardware.
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13. Enter the PLC's IP address and subnet mask. Select Ethernet from the subnet box.
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14. ClickOK to configure the Siemens client.

15. Once finished, open the View tab and select Catalog to hide the catalog window.

16. Save and exit the HW Configuration window.

17. To configure the PC station, click on the SIMATIC PC Station in the left pane of the SIMATIC Manager
window.

18. Double-click on Configuration.
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19. Click on the View tab and select Catalog.

20. Expand both the SIMATIC PC Station menu and the CP Industrial Ethernetmenu.

21. Double-click on General or any other suitable option.
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22. Enter the IP address of the PC running the SIMATIC Manager software, in addition to the correct sub-
net mask.

23. Select Ethernet from the subnet box.
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24. ClickOK to configure the PC station.

25. Once finished, open the View tab and select Catalog to hide the catalog window.

26. Save and exit the HW Configuration window.

For more information, refer to Step Three: Connecting the Client and the Server Driver.

Step Three: Connecting the Siemens Client and the Siemens Server Driver
Once the Siemens client and the PC Station have been successfully configured, the Siemens client and the
Siemens server must be connected.

1. To start, open the Options tab in the SIMATIC Manager window and select Configure Network.
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2. Click on the Siemens client's CPU 315-2 DP block. A series of rows should be displayed in the lower
half of the window.
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3. Right-click on the first row and select Insert New Connection.

4. ClickOK.
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5. Enter the IP address of the machine on which the Siemens TCP/IP Server Ethernet-Treiber runs.

6. Click Address Details and enter the rack/slot values of the device in the unsolicited driver with which
the Siemens client should communicate.
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7. ClickOK twice to successfully connect the Siemens client and server drivers. The Siemens client uses
these settings to communicate with the destination device at rack 0 and slot 2.

Note: The Local ID number (=1) identifies the connection between the two partners. This number is
used later when creating function blocks for reading and writing data.

8. Save and compile the data by opening the Network tab and selecting Save and Compile. ClickOK.

Note: There should be no errors on compilation.

For more information, refer to Step Four: Inserting Function Blocks.

www.ptc.com

42



Siemens TCP/IP Server Ethernet-Treiber

Step Four: Inserting Function Blocks
Once the Siemens client has been configured and connected with the Siemens server or unsolicited driver, it
must also be prepared to generate requests for the unsolicited partner. This is done by creating function
blocks, which can be used to read data from or write data to an unsolicited driver. The function block (FB)
used for reading data in this example is FB14 (GET). The function block (FB) for writing data is FB15 (PUT).

1. Expand the Siemens client menu, the CPU 315-2 DP menu, and the S7 Program[1]menu.

2. Double-click on Blocks andOB1.

3. LAD, STL, or FBD can be used to create function blocks. In this example, FBD is used. In the
LAD/STL/FBD window, click on the Insertmenu.
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4. Click Program Elements.

5. Expand the Libraries, SIMATIC_NET_CP, and CP 300menus.
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6. Double-click on FB14 GET to insert a function block to read data.
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7. Close the Program Elements window. "FB14" should be inserted as shown below.

8. Associate a data block (DB) with the function block (FB). To do so, click above the FB where there are
three red questionmarks.
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9. Enter the name of a data block. In this example, it is "DB2".

10. Click Yes to create the data block.

11. Fill in the other details as appropriate for the fields in the function block. Users should consider the fol-
lowing:

l "ADDR_1" is the address on the destination device in the unsolicited driver.

l "RD_1" is the address local to the PLC.

l The value at the remote address specified by "ADDR_1" is written (GET) to the local address
specified by "RD_1".
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l Enter the Local ID number that was generated when setting up the connection between the
Siemens client and the Siemens server driver in the ID field. In this example, the Local ID
number is 1.

The number of bytes in both the "ADDR_1" and "RD_1" fields should be same for the unso-
licited driver to respond correctly. Otherwise, an error occurs.

Note:Now that the GET function block has been created successfully, users must remember that
the block gets executed / triggered only on a rising edge (REQ).

12. Click Save and close the LAD/STL/FBD window.

For more information, refer to Step Five: Creating the DB3 Data Block.

www.ptc.com

48



Siemens TCP/IP Server Ethernet-Treiber

Step Five: Creating the DB3 Data Block
While configuring GET FB, the data block "DB3" was used for the "RD_1" field. This is the data block that sto-
res read values.

1. Right-click in the right pane of the SIMATIC Manager window and then select Insert New Object|
Data Block.

2. Change the name to "DB3."
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3. Double-click onDB3. To assign some memory to the data block, users canmake changes similar to
those shown below. Although the array size in this example is arbitrary, values should be specified to
fit a particular need.

4. Save and close the LAD/STL/FBD window.

For more information, refer to Step Six: Inserting PUT FB.

Step Six: Inserting PUT FB

1. Create a separate data block for the PUT FB, which holds the data that is written to the remote part-
ner. To insert this new data block, follow the steps in Step Five: Creating the DB3 Data Block but
name it "DB5."

2. Double-click onDB5, then specify a memory size. Although the array size in this example was chosen
arbitrarily, the values should be specified to fit a particular need.
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3. To insert the PUT FB, double-click onOB1 in the SIMATIC Manager window.

4. In LAD/STL/FBD, right-click in the blank space below GET FB.
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5. Click Insert Network and select the blank space below.

6. Click Insert | Program Elements.

7. Expand the Libraries, SIMATIC_NET_CP, and CP 300menus.

8. To insert a function block to write data, double-click on FB15 PUT.
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9. Close the Program Elements window.

10. Associate a data block (DB) with the function block (FB). To do so, click above the FB where there are
three red questionmarks.

11. Specify a name. In this example, "DB4" is used.

12. A window prompt requests confirmation of data block creation. Click Yes.

13. Fill in the other details as appropriate. Users should consider the following:

l "ADDR_1" address is on the destination device in the unsolicited driver.

l "SD_1" is the address local to the PLC.

l The value at the local address specified by "SD_1" is written (PUT) to the remote address spe-
cified by "ADDR_1".

l Enter the Local ID number that was generated when setting up the connection between the
Siemens client and the Siemens server driver in the ID field. In this example, the Local ID
number is 1.

Important: The number of bytes in both the "ADDR_1" and "SD_1" fields should be same
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for the unsolicited driver to respond correctly. Otherwise, an error occurs.

14. Click Save and close LAD/STL/FBD.

For more information, refer to Step Seven: Downloading to the PLC.
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Step Seven: Downloading to the PLC
Once the Siemens client has been prepared to generate Read / Write requests for the remote unsolicited
partner, the informationmust be downloaded to the PLC.

1. Click Siemens client in the left pane of the SIMATIC Manager window.

2. Select the PLC menu.

3. Select Download to begin downloading the project to the PLC.

4. ClickOK.

5. Click Yes.

Note: The Siemens client must be run to trigger the function blocks that generate Read / Write
requests.
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6. Double-click onOB1 in the SIMATIC Manager window.

7. In LAD/STL/FBD, click Debug | Monitor.

Note: LAD/STL/FBD should appear in Online Mode.
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8. To execute GET/PUT FBs, change the REQ value to 0 and then 1 to indicate the rising edge. To do so,
right-click on the REQ field and selectModify to 0 to force a zero to the field.
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9. Right-click on the REQ field and selectModify to 1 to force a value of one to the field.

www.ptc.com

58



Siemens TCP/IP Server Ethernet-Treiber

Note: Both of the FBs must next be configured to respond to the same rising edge for the SIMATIC
Manager's variables to be locally monitored andmodified.

10. In LAD/STL/FBD, click on PLC and selectMonitor/Modify Variables.

11. Enter the variables to be monitored. To view the changes made to this window, execute the function
blocks.
Note: Remember that the slot / rack value of the remote device with which the Siemens client is

communicating is "rack:0 slot:2". The values can be changed from the NetPro window. Users must
make sure that the Siemens server or unsolicited driver on the other end has a device with these
values and is running.
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